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Preface

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools
and documentation are constantly evolving to meet customer needs, so some actual
dialogs and/or tool descriptions may differ from those in this document. Please refer
to our web site (www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom
of each page, in front of the page number. The numbering convention for the DS
number is “DSXXXXXA”, where “XXXXX" is the document number and “A” is the
revision level of the document.

For the most up-to-date information on development tools, see the MPLAB® IDE
on-line help. Select the Help menu, and then Topics to open a list of available on-line
help files.

INTRODUCTION

This chapter contains general information that will be useful to know before using the
MCP2140 IrDA Standard Wireless Temperature Sensor Demo Board. Items discussed
in this chapter include:

» About This Guide

* Recommended Reading

* The Microchip Web Site

¢ Customer Support

© 2004 Microchip Technology Inc. DS51487A-page 1
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ABOUT THIS GUIDE

Document Layout

This document describes how to use the MCP2140 IrDA® Standard
Wireless Temperature Sensor Demo Board User’s Guide.

The manual layout is as follows:

e Chapter 1: Product Overview — Information about the MCP2140 IrDA Standard
Wireless Temperature Sensor Demo Board.

» Chapter 2: MCP2140 IrDA Standard Wireless Temperature Sensor Demo
Board — This chapter includes a detailed description of the hardware instructions
on how to get started with this demo board, a description of functions of the demo
board and instructions on running the demos.

* Appendix A: Schematic and Layouts — Shows the schematic and layout
diagrams for the MCP2140 IrDA Standard Wireless Temperature Sensor Demo
Board.

« Appendix B: Bill of Materials — Lists the parts used to build the MCP2140 IrDA
Standard Wireless Temperature Sensor Demo Board.

* Appendix C: Connection Sequence — Shows the high-level connection
sequence between a Primary device and the MCP2140 (Secondary device). This
connection sequence is shown at an overview level and does not detail exact
operation.

* Appendix D: 250 Byte Transmit Table — This table shows the data that is
transmitted by the program when in 250 Byte Transmit mode.

* Appendix E: Alternative Optical Transceiver Selection — This board was
designed to support the Vi:shay® TFDU 4100 (default selection), TFDU 4300 and
the Agilent® HSDL 3000. This section describes what needs to be done to
implement one of the other two options.

* Appendix F: Using AN888 Program with a Palm™ PDA — Shows how to use
the Palm PDA and Application Note 888, “Programming the Palm OS® for
Embedded IR Applications” (DS00888), to demonstrate the demo board.

DS51487A-page 2 © 2004 Microchip Technology Inc.



Preface

Conventions Used in this Guide

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Represents

Examples

Arial font:

Italic characters

Referenced books

MPLAB® IDE User's Guide

Emphasized text

...Is the only compiler...

digit

Initial caps A window the Output window
A dialog the Settings dialog
A menu selection select Enable Programmer
Quotes A field name in a window or | “Save project before build”
dialog
Underlined, italic text with A menu path File>Save
right angle bracket
Bold characters A dialog button Click OK
Atab Click the Power tab
‘bnnnn A binary number where nis a |‘'b00100, ‘b10

Text in angle brackets < >

A key on the keyboard

Press <Enter>, <F1>

Courier font:

Plain Courier

Sample source code

#defi ne START

Filenames aut oexec. bat

File paths c:\nccl8\h

Keywords _asm _endasm static
Command-line options - Opa+, -Opa-

Bit values 0, 1

Italic Courier

A variable argument

file.o,wherefilecanbe
any valid filename

Ooxnnnn

A hexadecimal number where
n is a hexadecimal digit

OxFFFF, 0Ox007A

Square brackets [ ]

Optional arguments

nccl8 [options] file
[ opti ons]

Curly brackets and pipe
character: { |}

Choice of mutually exclusive
arguments; an OR selection

errorlevel {0]1}

Ellipses...

Replaces repeated text

var _name [,
var _nane. . .]

Represents code supplied by
user

void main (void)
{
}

© 2004 Microchip Technology Inc.
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RECOMMENDED READING

This user's guide describes how to use the MCP2140 IrDA Standard Wireless Temper-
ature Sensor Demo Board. Other useful documents are listed below. The following
Microchip documents are available and recommended as supplemental reference
resources.

MCP2140 Data Sheet (DS21790)
This data sheet provides detailed information regarding the MCP2140 device.

THE MICROCHIP WEB SITE

Microchip provides online support via our WWW site at www.microchip.com. This web
site is used as a means to make files and information easily available to customers.
Accessible by using your favorite Internet browser, the web site contains the following
information:

* Product Support — Data sheets and errata, application notes and sample
programs, design resources, user’s guides and hardware support documents,
latest software releases and archived software

e General Technical Support — Frequently Asked Questions (FAQ), technical
support requests, online discussion groups and the Microchip consultant program
member listing

» Business of Microchip — Product selector and ordering guides, latest Microchip
press releases, listing of seminars and events, listings of Microchip sales offices,
distributors and factory representatives

CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

« Distributor or Representative

» Local Sales Office

* Field Application Engineer (FAE)

« Technical Support

« Development Systems Information Line

Customers should contact their distributor, representative or field application engineer
(FAE) for support. Local sales offices are also available to help customers. A listing of
sales offices and locations is included in the back of this document.

Technical support is available through the web site at: http://support@microchip.com

In addition, there is a Development Systems Information Line which lists the latest ver-
sions of Microchip's development systems software products. This line also provides
information on how customers can receive currently available upgrade Kkits.

The Development Systems Information Line numbers are:
1-800-755-2345 — United States and most of Canada
1-480-792-7302 — Other International Locations

DS51487A-page 4
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Chapter 1. Product Overview

1.1 INTRODUCTION

This chapter provides an overview of the MCP2140 IrDA® Standard Wireless
Temperature Sensor Demo Board and covers the following topics:
* What is the MCP2140 IrDA Standard Wireless Temperature Sensor Demo Board?

* What the MCP2140 IrDA Standard Wireless Temperature Sensor Demo Board kit
includes

1.2 WHAT IS THE MCP2140 IrDA STANDARD WIRELESS TEMPERATURE
SENSOR DEMO BOARD?

The MCP2140 IrDA Standard Protocol Stack Controller device allows the system
designer to implement a low-cost wireless IR port in any application, providing support
for the IrDA standard protocol stack and IrDA standard bit encoding/decoding.

The MCP2140 IrDA Standard Wireless Temperature Sensor Demo Board is used to
evaluate and demonstrate the MCP2140 device in a data-logging application by
transmitting ambient temperature to a PDA (e.g., Paim™ PDA) or laptop computer. It
is intended to serve as an example to assist system designers in developing an IrDA
standard node using the MCP2140 device.

1.3 WHAT THE MCP2140 IrDA STANDARD WIRELESS TEMPERATURE SENSOR
DEMO BOARD KIT INCLUDES

This MCP2140 IrDA Standard Wireless Temperature Sensor Demo Board Kit includes:

* The MCP2140 IrDA Standard Wireless Temperature Sensor Demo Board
« Demo Board Firmware

* MCP2140 IrDA Standard Wireless Temperature Sensor Demo Board User’s
Guide

© 2004 Microchip Technology Inc. DS51487A-page 5
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Chapter 2. MCP2140 IrDA Sandard Wireless
Temperature Sensor Demo Board

2.1 INTRODUCTION

The MCP2140 IrDA Standard Wireless Temperature Sensor Demo Board
demonstrates the MCP2140 device in a real-world application. In addition, the system
designer will be able to use this design as an example of how to integrate an IR port
into their system.

2.2 FEATURES

The MCP2140 IrDA Standard Wireless Temperature Sensor Demo Board has the
following features:

* Demo board communicates directly to Primary device (PDA or laptop computer)
running a terminal emulation application program
« Data is transmitted in an easy-to-read format

* Reprogrammable PIC18F1320 with In-Circuit Debugger (ICD) interface for user
application development

« Header that allows either several board signals to be monitored or allows the
MCP2140 IrDA Standard Wireless Temperature Sensor Demo Board to be
interfaced to user’s system

* Three LEDs that indicate MCP2140 status (CTS, DSR and PHACT activity)

« Powered by three AAA batteries

« Power jumper and power LED indicator

2.3 GETTING STARTED

The MCP2140 IrDA Standard Wireless Temperature Sensor Demo Board is fully assem-
bled and tested for evaluation and demonstration of the MCP2140 features. A block
diagram of the demo board is shown in Figure 2-1. Refer to Appendix A. “Schematic
and Layouts” and Appendix B. “Bill-Of-Materials (BOM)" for more detailed circuit

information.
FIGURE 2-1: MCP2140 DEMO BOARD BLOCK DIAGRAM
LEDs
r Three AAA 1 O Power

L 1.5V Batteries] | — ODSR

System —O CTS
Power PHACT Optical
U2 Transceiver
J1 Ul
I 7,/ Control/Status TXIR
3 “ 2, UART RXIR
ICD Header NN 7 MCP2140
(for programming) st
S2 ©) RESET
L% =7
fp — ®
Ull IrDA

Standard Controller

Temp
TC1047A Sensor
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231 The Hardware
Figure 2-2 shows the layout of the MCP2140 IrDA Standard Wireless Temperature
Sensor Demo Board with points of interest encircled.

Figure 2-3 shows the switches used to reset the PIC18F1320 and selects one of two
demo programs. The RESET switch resets the PIC18F1320, while switch S2 is used
for program selection.

FIGURE 2-2: MCP2140 IrDA® STANDARD WIRELESS TEMP SENSOR DEMO BOARD
Signal Header
J1
\
zle®
e () == |CD Header
p o
Sl @
!
o
LN
[ | === Optical Transceiver
[ | [ ] Supports:
TFDU 4100 (Default)
C6 C13 Cc14 V2 TFDU 4300 (Optional)
E hun HSDL 3000 (Optional)
c11.C4 L PIC18F1320
N /
\ s

Demo Board Power Jumper Switches

Shorted = Board connected to battery supply : )
Open = Board NOT connected to battery supply LED Signal Indicators
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FIGURE 2-3:

MCP2140 IrDA® STANDARD WIRELESS TEMP SENSOR DEMO BOARD
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2.3.2 The Embedded System Firmware

There are two programs that can be demonstrated on the demo board. These are:

« The transmission of a 250 byte data string from a table in the PIC18F1320 to the
Primary device.

* The transmission of the “temperature” reading of the TC1047A to the Primary
device.

Typical Primary devices include Palm or Pocket PC PDAs and Laptop PCs with an IrDA
standard infrared port.

The PIC18F1320 source code for the MCP2140 IrDA Standard Wireless Temperature
Sensor Demo Board is available for download from the Microchip web site at
www.microchip.com.

2.3.2.1 “TRANSMIT 250 BYTE DATA STRING” PROGRAM DESCRIPTION

This program will be selected when the RESET switch is depressed and then released
(with the S2 switch not pressed). The PIC18F1320 will initialize the system and wait to
receive a data byte. Once a data byte is received, the PIC18F1320 will transmit a
250-byte table from memory to the MCP2140.

The PIC18F1320 follows the flow control of the MCP2140 to ensure that data is not lost.

The MCP2140 handles all the IrCOMM protocol for the data packets that it receives
from the PIC18F1320.

Once the table has completed transmission, the PIC18F1320 will wait to receive the
next character that will cause the 250-byte table to be transmitted (again).

The 250-byte data table transmitted from the MCP2140 IrDA Standard Wireless Temper-
ature Sensor Demo Board to the Primary device is shown in Appendix D. “MCP2140
250 Byte Data Transmit Table”. These values will be displayed in the Primary device’s
Terminal Emulation program window.

2.3.2.2 “TRANSMIT TEMPERATURE” PROGRAM DESCRIPTION

This program will be selected when both the RESET and S2 switches are depressed,
the RESET switch is released and the S2 switch is held momentarily. The PIC18F1320
will initialize the system and wait to receive a data byte. Once a data byte is received,
the PIC18F1320 will continuously transmit the following string:

“Temp = xx" to the MCP2140, approximately once per second, where xx is the
temperature in °C.

The PIC18F1320 follows the flow control of the MCP2140 to ensure that data is not lost.

The “measured” temperature will vary as a result of the system voltage of the demo
board. This is due to the PIC18F1320 being powered directly from the AAA batteries
and the A/D module using Vpp as its reference voltage.

The current firmware implementation will transmit a larger value to the Primary device
as the battery voltage decreases, given a constant temperature.

A firmware technique to correct for this would be to use the PIC18F1320 LVD module.
A hardware technigue would be to use a voltage regulator to ensure that the system
voltage remains constant, regardless of the voltage output of the batteries.

DS51487A-page 10 © 2004 Microchip Technology Inc.



2.4 RUNNING THE DEMOS

This demo board can interface to any Primary device that implements the rCOMM
9-wire “cooked” protocol layer. Some typical Primary devices include:

1. Palm PDA
2. Pocket PC PDA
3. Laptop PC with IrDA Standard Port

To communicate with the MCP2140 IrDA Standard Wireless Temperature Sensor
Demo Board, these devices must run a terminal emulation program (such as
HyperTerminal® on the PC).

For the Palm OS® devices, there is a program called Onl i ne. For more information
about Online and the setup of this application, refer to page 23 of Application Note 858,
“Interfacing the MCP215X to a Host Microcontroller”, or go to the Mark Space web site
(www.MarkSpace.com).

Microchip has not evaluated any Terminal Emulation programs for Pocket PC OS
devices at this time. Refer to Section 2.4.1 “ Alternative Primary Device Programs”
for an alternative Primary device program.

For a Windows® XP system, a 3rd-party driver needs to be installed to “create” the
“virtual port” that HyperTerminal needs to connect to that allows it to use the IR port for
communications. This driver is called rCOMM2K and is available at
www.IRCOMM2K.de. Please evaluate this product before installing onto your system
to ensure that it will meet your requirements.

Microchip does not imply any suitability to your system requirements of any of these
3rd-party products. Please evaluate each product’s specifications and requirements
before installing onto your system.

Two step-by-step examples for this demo will be presented. Section 2.4.2 “Using a
Palm PDA or Equivalent as the Primary Device” shows the steps using a Palm PDA,
while Section 2.4.3 “Using a Laptop PC as the Primary Device” shows the steps
using a Windows® XP based laptop with IR port.

24.1 Alternative Primary Device Programs

Microchip also has some example Primary Device programs that could be used to
demonstrate the MCP2140 IrDA Standard Wireless Temperature Sensor Demo Board.
These programs were not developed for this demo board and may not display all
modes of operation in a straight-forward manner (such as the “Transmit Temperature”
program). These programs are discussed in the following application notes:

« For Palm OS - Application Note 888, “Programming the Palm 0S® for Embedded
IR Applications” (DS00888)

« For Pocket PC OS - Application Note 926, “Programming the Pocket PC OS for
Embedded IR Applications” (DS00926)

« For Windows XP - Application Note 941, “Programming Windows® XP for
Embedded IR Applications” (DS00941)

Appendix F. “Using AN888 Program with a Palm™ PDA” shows how to use the
Palm PDA and AN888 to demonstrate the demo board. The operation for the Pocket
PC and Windows XP applications are similar and are discussed in AN926 and AN941.

© 2004 Microchip Technology Inc. DS51487A-page 11
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24.2 Using a Palm PDA or Equivalent as the Primary Device

Section 2.4.2.1 “Operating the “Transmit 250 Byte Data String” program”
discusses how to operate the “Transmit 250 Byte Data String” program, while Section
2.4.2.2 “Operating the “Transmit Temperature” Program” discusses how to
operate the “Transmit Temperature” program.

2.4.2.1 OPERATING THE “TRANSMIT 250 BYTE DATA STRING” PROGRAM

1. Ensure 3 AAA batteries are properly inserted into the battery holder.

2. Connect JP1 (closed position). The power LED (D5) will turn on. After a few
seconds, the PHACT LED (D4) will also turn on, indicating that the MCP2140’s
protocol handler is in the Non-Discovery Mode (NDM) state or the MCP2140 is
in the Low-power mode.

3. Depress and release the RESET button.

Turn on the Palm (or equivalent) PDA.

5.  With both devices on a flat surface, place the Palm PDA about 25 cm (107) away

from the MCP2140 IrDA Standard Wireless Temperature Sensor Demo Board,

pointing the IR port of the Palm PDA (dark red window at the top of the PDA)
toward the two clear LEDs (D1, D6) on the MCP2140 IrDA Standard Wireless

Temperature Sensor Demo Board.

Open the Online program on the Palm PDA.

Tap the ON button.

Tap the 123 button.

Tap any number (0-9). This is the command that will be received by the

MCP2140 IrDA Standard Wireless Temperature Sensor Demo Board, instructing

the program to send a data string back to the Palm PDA. At this time, the DSR

(D2), CTS (D3) and PHACT (D4) LEDs are turned off.

10. Send the command by tapping the DONE button. Once the DONE button has
been tapped, the DSR and PHACT LEDs will turn on and the CTS LED will strobe
until all the data has been transmitted.

11. The Palm PDA window should receive a string of data as shown in Figure 2-4.

»

© © N

FIGURE 2-4: ONLINE WINDOW AFTER RECEIVING 250 BYTE DATA
STRING

32345678
4bcdef gh
52345678
6BEDEFGH
72345678
8bcdef gh
92345678
ABCDEFCGH
B2345678
Chcdef gh
D2345678
EBCDEFGH
F2345678
1bcdef gh
22345678

[abc[123[Intl] [CtEsd @

[l Q@MW ¥ Macros

12. Repeating steps 8 through 10 will cause the Palm PDA to transmit another data
byte and receive another data string.

13. In the Palm window, tap the ON button (it becomes unshaded - normal display).
The DSR and CTS LEDs will immediately turn off and the PHACT LED will turn
on in about 10 seconds.

DS51487A-page 12 © 2004 Microchip Technology Inc.



2.4.2.2 OPERATING THE “TRANSMIT TEMPERATURE” PROGRAM

1. Ensure 3 AAA batteries are properly inserted into the battery holder.

2. Connect JP1 (closed position). The power LED (D5) will turn on. After a few
seconds, the PHACT LED (D4) will also turn on, indicating that the MCP2140’s
protocol handler is in the NDM (Non-Discovery Mode) state or the MCP2140 is
in the Low-power mode.

3. Depress the RESET and S2 buttons, then release the RESET button (keep the
S2 button depressed).

4. Release the S2 button.

Turn on the Palm (or equivalent) PDA.

6. With both devices on a flat surface, place the Palm PDA about 25 cm (10”) away
from the MCP2140 IrDA Standard Wireless Temperature Sensor Demo Board,
pointing the IR port of the Palm PDA (dark red window at the top of the PDA)
toward the two clear LEDs (D1, D6) on the MCP2140 IrDA Standard Wireless
Temperature Sensor Demo Board.

7. Open the Online program on the Palm PDA.

Tap the ON button. (it becomes shaded - reverse video).

9. Tap the 123 button.

10. Tap any number (0-9). This is the command that will be received by the
MCP2140 IrDA Standard Wireless Temperature Sensor Demo Board, instructing
the program to begin sending temperature data to the Palm PDA. At this time,
the DSR (D2), CTS (D3) and PHACT (D4) LEDs are turned off.

11. Send the command by tapping the DONE button. Once the DONE button has
been tapped, the DSR and PHACT LEDs will turn on and the CTS LED will strobe
until all the data has been transmitted.

12. The Palm PDA window should receive a string of data about every second, as
shown in Figure 2-5.

FIGURE 2-5: ONLINE WINDOW AFTER RECEIVING TEMPERATURE DATA
STRING

o

©

28
28
28

Tenp
Tenp
Tenp

[abc[123[Intl] [Ct]Esd ©

M J[Onflog @@V ¥ Macros

13. Device U4 is the TC1047A temperature sensor device. The output is connected
to an A/D channel of the PIC18F1320. Changing the temperature of this device
will effect the "temperature” value that is transmitted to the Primary device.

14. In the Palm window, tap the ON button (it becomes unshaded - normal display).
The DSR and CTS LEDs will immediately turn off and the PHACT LED will turn
on in about 10 seconds.

Note: Temperature value transmitted by the PIC18F1320 will be dependent on
battery voltage (see Section 2.3.2.2 ““ Transmit Temperature” Program
Description”).
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2.4.3 Using a Laptop PC as the Primary Device

To use a Laptop PC with an IrDA standard port as the Primary device, the Terminal
Emulation program needs to be able to “connect” to the IR port. In Windows 2000 and
Windows XP systems, this requires the installation of a 3rd Party driver. One 3rd Party
driver is called “IrCOMM2K (www.IRCOMM2K.de). Once the IrCOMM2K driver is
installed, it creates a “new” com port (such as COM7). This is a virtual serial port that
the PC Terminal Emulation application program (such as HyperTerminal) can be con-
nected to. Then HyperTerminal needs to be configured. Refer to Section

2.4.3.1 “Configuring HyperTerminal”.

After configuring HyperTerminal, Section 2.4.3.2 “Running the Demo Using
HyperTerminal” discusses how to operate the MCP2140 IrDA Standard Wireless
Temperature Sensor Demo Board via HyperTerminal.

2.4.3.1 CONFIGURING HYPERTERMINAL

1. Startthe HyperTerminal Emulation program (usually located under the Programs
> Accessories > Communications directory.

FIGURE 2-6: CONNECTION DESCRIPTION WINDOW

Connection Description

IQ‘ New Connection

Enter a name and chooze an icon for the connection:
Hame:

lean:

[ 0K H Cancel ]

2. Inthe Connection Description window, select the Cancel button.
In the programs menu, select File > Properties.

4. Inthe New Connection Properties window on the Connect To tab, go to the
“Connect Using” pull-down and select the virtual serial port created by the
IrCOMM2K driver installation (such as COM7).

FIGURE 2-7: NEW CONNECTION PROPERTIES WINDOW

w

Connect Ta | Settings

% Mew Connection Change |con..

LCountry/region:
Enter the area code without the long-distance prefis.
Area code:

Phone number:

Comrectushy: AN
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5. Select the Configure button.

FIGURE 2-8: COM7 PROPERTIES WINDOW
COM7T Properties @g|
Port Settings
Bits per second: | yRSEN]

Databits: |8 E¥3

Parity: | Mone w

Stop bits: |1 w

Flows contral: | Mone w
[ QK. ] [ Cancel ] [ Apply ]

6. Inthe COMx (COM7) Properties window, configure the Port Setting for:
- “Bits per second:” = 115200

- “Data Bits:"=8
- “Parity:” = None
- “Stop Bit:" =

- “Flow Control:” = None
7. Select the OK button.
8. Inthe New Connection Properties window, select the Settings tab.
FIGURE 2-9: NEW CONNECTION PROPERTIES WINDOW - SETTINGS TAB

Cornect Ta | Settings

Function, araw, and chl keys act as
@ilemnalkess O Windows keps
Backspace key sends

@ Cu+H O Del O Cul+H, Space, Chl+H

Ernulation:

Auto detect -

Telhet terminal 10: ANSI

4

Backscroll buffer lines: | 500

[] Play sound when connecting or disconnecting

[ Input Translation. . ] [ ASCH Setup.... ]

9. Configure the New Connection Properties Settings.

- Under the “Function, arrow and control keys act as” item, select the
Terminal Keys radio button.

- Under the “Backspace key sends” item, select the Ctrl+H radio button.
From the “Emulation” pull-down menu, select Auto-detect.

- For “Telnet Terminal ID”, enter ANSI.

- For “Backscroll buffer lines”, select 500 from the pull-down menu.
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10. Select the ASCII Setup button, this will open a new window.
FIGURE 2-10: NEW CONNECTION PROPERTIES - ASCII SETUP

C t To | Settings .

LLLEAL A5CI Sending
Send line ends with line feeds
[¥] Echo typed characters locallé

MNew Connection Properties / ASCII Setup EI E|

Furneti ind ctrl keys act as

(O Windows keys

Backzpace key zends

® C+H O Dl O ChlH. Space. Ctil+H Lire delay: |0 millizeconds.
Emulation: Character delay: (0 milliseconds.
Auto detect v
Telhet terminal 10 ANS| ASCI Fleceiving

Bacbcialibuicfinesg) 500 £ [ &ppend line feeds to incoming line ends

[] Play sound when connecting or disconnecting I:l Eanse incnming data to 7-hit ASCI

[ et Trantation.. ] @/ Wiap lines that exceed terminal width

[ ok ][ cencel

11. In the “ASCII Sending” portion of the window:
- Check “Send Line ends with line feeds”.
- Check “Echo typed characters locally”.
- Set the “Line Delay” and the “Character Delay” to ‘0’ milliseconds.
12. In the “ASCII Receiving” portion of the window:
- Uncheck “Append line feeds to incoming line ends”.
- Uncheck “Force incoming data to 7-bit ASCII”.
- Check “Wrap lines that exceed terminal width”.
13. Select the OK button.
14. Select the Input Translation button.
- In the "Host System Encoding Method” window, select Shift-JIS. Then
select the OK button in the New Connection Properties window.

FIGURE 2-11: NEW CONNECTION PROPERTIES - HOST SYSTEM
ENCODING METHOD

New Connection Properties

Cornect Ta | Settings

d chil keys act as
O windows keys

Functi

Host System Encoding Method EJE|

Backspace key sends
© L O Dol O Cukld. Space, CtieH Select Hast Spstem Encading Methad

Emulation:

Auto detect v

O Standard JIS
Telnet terminal 10: AMS|

Backscrall buffer lines: | 500 E

[] Play sound when connecting or disconnecting [ Ok, ] [ Cancel l

‘ [ Input Tranglation... ]M ]

15. Now that all the settings are configured, in HyperTerminal's pull-down menu,
select File > Save As. Select the name that you wish.
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2.4.3.2 RUNNING THE DEMO USING HYPERTERMINAL

Now that the HyperTerminal application program is configured, the PC can communi-
cate with the MCP2140 IrDA Standard Wireless Temperature Sensor Demo Board.
Section 2.4.3.2.1 “Operating the “Transmit 250 Byte Data String” Program”
discusses how to operate the “Transmit 250 Byte Data String” program, while Section
2.4.3.2.2 “Operating the “Transmit Temperature” Program” discusses how to
operate the “Transmit Temperature” program.

Note: Hyperterminal® should be disabled before establishing a connection
between the PC and the MCP2140 IrDA Standard Wireless Temperature
Sensor Demo Board. Make sure that any other programs (e.g., HotSync®)
connected to the IR ports are disabled.

2.4.3.2.1 Operating the “Transmit 250 Byte Data String” Program

1. Ensure 3 AAA batteries are properly inserted into the battery holder.

2. Connect JP1 (closed position). The power LED (D5) will turn on. After a few
seconds, the PHACT LED (D4) will also turn on, indicating that the MCP2140 is
in the Non-Discovery Mode (NDM) state.

3. Depress and release the RESET button.

Turn on the PC laptop.

5.  With both devices on a flat surface, place the Palm PDA about 25 cm (107) away
from the MCP2140 IrDA Standard Wireless Temperature Sensor Demo Board,
pointing the IR port of the PC toward the two clear LEDs (D1, D6) on the
MCP2140 IrDA Standard Wireless Temperature Sensor Demo Board.

6. Ifthe PC is configured to show the IR icon in the system tray, a single IR LED
icon will be displayed. Placing the mouse cursor over this icon will display the
message “MCP2140 A5 is in range”, where “MCP2140 A5” is the Device ID of
the MCP2140.

7. Start the HyperTerminal program using the saved setting from Section
2.4.3.1 “Configuring HyperTerminal”. When HyperTerminal starts, it is in the
connected state. To disconnect, click on the telephone icon (4th icon from left on
toolbar). To connect, click on the telephone icon (3rd icon from left). Depending
on the current state of the HyperTerminal session, only one of the two telephone
icons will be active (the other will be grayed out).

8. Ensure that the HyperTerminal session indicates “Connected” (lower-left of
HyperTerminal window) and the icon in the system tray changes to two IR LEDs
facing each other and “talking”.

9. Place the mouse cursor over the IR icon in the system tray. The message
displayed now says “Wireless link with MCP2140 A5 at 9600 bps”. This shows
that a link is established for data communication and that the IR communication
rate is 9600 bps (even though the HyperTerminal program is “talking” to the driver
at 115200, the IrDA standard hardware is communicating at the rate negotiated
with the MCP2140.

10. Type any number (0-9) in the HyperTerminal window. The MCP2140 IrDA Stan-
dard Wireless Temperature Sensor Demo Board requires a receive byte before
transmitting its data. This is due to the requirement of most PDAs needing to
transmit a data byte before opening the IR Link. The data byte is sent as it is
typed. At this time, the DSR (D2), CTS (D3) and PHACT (D4) LEDs are turned off.

11. The HyperTerminal window should receive a string of data as shown in
Appendix D. “MCP2140 250 Byte Data Transmit Table”.

12. Repeating steps 10 and 11 will cause the PC to transmit another data byte and
to receive another data string.

13. Disconnect (close) the HyperTerminal session. The DSR and CTS LEDs will
immediately turn off and the PHACT LED will turn on in about 10 seconds.

»
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2.4.3.2.2  Operating the “Transmit Temperature” Program

1.
2.

10.

11.

12.

13.

Ensure 3 AAA batteries are properly inserted into the battery holder.

Connect JP1 (closed position). The power LED (D5) will turn on. After a few
seconds, the PHACT LED (D4) will also turn on, indicating that the MCP2140 is
in the NDM (Non-Discovery Mode) state.

Depress the RESET and S2 buttons, then release the RESET button (keep the
S2 button depressed).

Release the S2 button.

With both devices on a flat surface, place the MCP2140 IrDA Standard Wireless
Temperature Sensor Demo Board about 25 cm (10”) away from the PC (dark red
window at the front or sides of the PC) toward the two clear LEDs (D1, D6) on
the MCP2140 IrDA Standard Wireless Temperature Sensor Demo Board.

If the PC is configured to show the IR icon in the system tray, a single IR LED
icon will be displayed. Placing the mouse cursor over this icon will display the
message “MCP2140 A5 is in range”, where “MCP2140 A5” is the Device ID of
the MCP2140.

Start the HyperTerminal program by using the saved setting from Section
2.4.3.1 “Configuring HyperTerminal”. When HyperTerminal starts, it is in the
connected state. To disconnect, click on the telephone icon (4th icon from left on
toolbar). To connect, click on the telephone icon (3rd icon from left). Depending
on the current state of the HyperTerminal session, only one of the two telephone
icons will be active (the other will be grayed out).

Ensure that the HyperTerminal session indicates “Connected” (lower-left in
HyperTerminal window) and that the icon in the system tray changes to two IR
LEDs facing each other and “talking”.

Place the mouse cursor over the IR icon in the system tray. The message
displayed now says “Wireless link with MCP2140 A5 at 9600 bps”. This shows
that a link is now established for data communication, and that the IR
communication rate is 9600 bps (even though the HyperTerminal program is
“talking” to the driver at 115200, the IrDA standard hardware is communicating
at the rate negotiated with the MCP2140).

Type any number (0-9) in the HyperTerminal window. The MCP2140 IrDA Stan-
dard Wireless Temperature Sensor Demo Board requires a receive byte before
transmitting it's data. This is due to the requirement of most PDAs needing to
transmit a data byte before opening the IR Link. The data byte is sent as it is
typed. At this time, the DSR (D2), CTS (D3) and PHACT (D4) LEDs are turned
off.

The PC HyperTerminal window should receive a string of data about every
second. This data string has the format “Temp = xx”, where xx is the measured
temperature in °C.

Device U4 is the TC1047A Temperature Sensor device. The output is connected
to an A/D channel of the PIC18F1320. Changing the temperature of this device
will effect the "temperature” value that is transmitted to the Primary device.
Disconnect (close) the HyperTerminal session. The DSR and CTS LEDs will
immediately turn off and the PHACT LED will turn on in about 10 seconds.

Note: Temperature value transmitted by the PIC18F1320 will be dependent on
battery voltage (see Section 2.3.2.2 ““Transmit Temperature” Program
Description™).
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2.5 MCP2140 IrDA STANDARD WIRELESS TEMPERATURE SENSOR DEMO
BOARD DESCRIPTION

The MCP2140 IrDA Standard Wireless Temperature Sensor Demo Board is designed
to demonstrate and evaluate an IR port implementation using the MCP2140 device.
The following sections describe each element of this demo board in further detail.

2.5.1 Power

The MCP2140 IrDA Standard Wireless Temperature Sensor Demo Board is powered
by three AAA batteries, generating a nominal voltage of 4.5V. Jumper JP1 is the power
switch on the board. LED D5 is the power indicator, turning on when power is applied
via JP1.

252 MCP2140 IrDA Protocol Stack Controller Device

This demo board highlights the MCP2140 IrDA Protocol Stack Controller device (U2)
to demonstrate the implementation of an IR port in an embedded system application.
The MCP2140 device handles all IrDA standard protocol tasks, while allowing the
system designer to easily interface the device to a microcontroller via a standard UART
port.

The key signals for the MCP2140-to-microcontroller interface are shown in Table 2-1.
Further information on the Host Controller interface may be obtained from the
MCP2140 data sheet (DS21790).
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TABLE 2-1:

MCP2140 HOST UART INTERFACE PINS

Pin

Pin Name |Number

(SSOP)

Pin
Type

Buffer
Type

Description

X

8

TTL

Asynchronous receive; from Host Controller UART

RX

9

o

Asynchronous transmit; to Host Controller UART

RI

10

TTL

Ring Indicator. The state of this bit is
communicated to the IrDA® standard Primary
device.

1 = No Ring Indicate Present

0 = Ring Indicate Present

DSR

11

Data Set Ready. Indicates that the MCP2140 has
established a valid infrared link with a Primary
device. This signal is locally emulated and not
related to the DTR bit of the IrDA standard Primary
device. (Note 1)
1 = An IR link has not been established

(No IR Link)
0 = An IR link has been established (IR Link)

DTR

12

TTL

Data Terminal Ready. Indicates that the embedded
device connected to the MCP2140 is ready for IR
data. The state of this bit is communicated to the
IrDA Primary device, via the IrDA standard DSR bit
carried by IrCOMM.

1 = Embedded device not ready

0 = Embedded device ready

CTS

13

Clear to Send. Indicates that the MCP2140 is
ready to receive data form the Host Controller. This
signal is locally emulated and not related to the
CTS/RTS bit of the IrDA standard Primary device.
1 = Host Controller should not send data

0 = Host Controller may send data

RTS

14

TTL

Request to Send. Indicates that a Host Controller is
ready to receive data from the MCP2140. This
signal is locally emulated and not related to the
CTS/RTS bit of the IrDA standard Primary device.
1 = Host Controller not ready to receive data

0 = Host Controller ready to receive data

CD

19

ST

Carrier Detect. The state of this bit is
communicated to the IrDA standard Primary device
via the IrDA standard CD bit.

1 = No Carrier Present

0 = Carrier Present

Legend:

Note 1:

TTL = TTL compatible input

| = Input

ST = Schmitt Trigger input with CMOS levels
O = Output

The state of the DTR output pin does not reflect the state of the DTR bit of the IrDA
standard Primary device.

DS51487A-page 20

© 2004 Microchip Technology Inc.




The key signals for the MCP2140-to-IR transceiver circuit are shown in Table 2-2.
Further information on the IR transceiver interface may be obtained from the MCP2140
data sheet (DS21790).

TABLE 2-2: MCP2140 IR INTERFACE PINS

Pin

Pin Name |Number _I_Pme BTUff(Zr Description
(ssop) | YPe | P
RXPDREF 1 | A IR Receive Photo Detect Diode reference voltage.
This voltage will typically be in the range of VDD/2.
TXIR 2 (0] —  |Asynchronous transmit to IrDA® standard
transceiver.
RXPD 20 | A IR RX Photo Detect Diode input. This input signal is

required to be a pulse to indicate an IR bit. When
the amplitude of the signal crosses the amplitude
threshold set by the RXPDREF pin, the IR bit is
detected. The pulse has minimum and maximum
requirements as specified in the MCP2140 data
sheet, Electrical Characteristics table,

Parameter IR131A.

Legend: A = Analog P = Power
| = Input O = Output

In addition to the signals described in Tables 2-1 and 2-2, the PHACT (Protocol Handler
Active) output signal indicates which mode the MCP2140 IrDA standard protocol
controller state machine is in (O = NDM or Low-power mode, 1 = Discovery or NRM)
and is connected to the PHACT LED (D4); the RESET input is connected to the RESET
output of the Host Controller (I/O pin RA4), which asserts low after the RESET
push-button switch is asserted; the Rl (Ring Indicator) input is pulled to ground; and the
OSC1 and OSC2 pins are connected to an external 7.3728 MHz oscillator, as specified
in the MCP2140 data sheet (allowing the device to transmit at 9600 baud).

25.21 MCP2140 OPERATION

The MCP2140 (U3) implements the 9-wire “cooked” service class in the rCOMM
application layer protocol of the IrDA standard specification. FfCOMM is the IrDA
standard specification for the replacement of the communication ports (serial and
parallel) of a PC. The MCP2140 allows the replacement of the serial cable with a wire-
less interface. The MCP2140 implements the entire protocol layer, and the Host
Controller (PIC18F1320) “talks” to the MCP2140 as if it were a serial port with flow
control.

The MCP2140 operates as a Secondary device only, so it will not initiate IrDA standard
communication with other IrDA standard devices (neither a Secondary device nor a
Primary device).

Appendix C. “MCP2140 Connection Sequence Overview” shows the connection
sequence between a Primary device and the MCP2140 (Secondary device). This
connection sequence is shown at an overview level and does not show exact
operation.
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25.3 PICmicro® Microcontroller Functions

The MCP2140 IrDA Standard Wireless Temperature Sensor Demo Board interfaces to
the PIC18F1320 microcontroller (U1). This device was chosen for this application
because it has a UART port, an A/D Converter (ADC) for the temperature sensor
analog output, Flash memory for reprogrammability, a small footprint (package) and is
low-power.

The PIC18F1320 interfaces to the MCP2140 as described in Section 2.5.2 “MCP2140
IrDA Protocol Stack Controller Device”.

The TC1047A temperature sensor indicates the temperature by outputting an analog
signal whose magnitude corresponds to the temperature of the device. This signal is
input on analog channel ANO (pin 1).

The MCLR input of the PIC18F1320 is connected to the RESET push button switch.
The device is reset when the RESET push button is depressed.

I/0 pin RBO is connected to the S2 push button switch. The state of the switch is polled
immediately after the device is reset (via the RESET push button), allowing the
microcontroller to determine which firmware program (“Data String Transmit” or
“Temperature Transmit)” to execute.

The PIC18F1320 is connected to a standard In-Circuit Serial Programming™ (ICSP™)
header (J1) to allow easy program access to the device.

254 IR Transceiver Circuit

The IR transceiver circuit utilizes an integrated optical transceiver. The circuit allows
any one of three devices to be used. These are:

1. Vishay® TFDU 4100 (default device)
2. Vishay TFDU 4300
3. Agilent® HSDL 3000

If you wish to test with either of the other optical transceivers, the TFDU 4100 and
associated components need to be removed and the components for the desired
optical transceiver need to be installed (see the Appendix B. “Bill-Of-Materials
(BOM)").

Figure 2-12 shows the circuit that is used to shape the waveform of the optical Trans-
ceiver’'s RXD output. This is done to ensure that the RXD pulse width does not exceed
the specifications of the MCP2140 RXPD input (IR131A) (refer to Parameter IR131A
in the MCP2140 data sheet, DS21790). The resistor divider R18 and R13 sets the
RXPDREF reference threshold. Transistor Q8 (MMUNZ2111LT1) has internal resistors.
If you wish to evaluate a simple PNP device, Q8 can be replaced and resistors for R15
and R20 may need to be added. If R20 is added, do not forget to cut the trace that
shorts-out the resistor.

FIGURE 2-12: MCP2140 RXPD WAVEFORM SHAPING CIRCUIT
Vpp
Vop R7
100Q
R18
TP1 10 kQ R15
(RXPDREFI—%— :
RXPDRE’;PDREF Q6 RV OPR;I—ZO C"g ngc?m Optical
(RXPD} ng of ofT | & PF  Transceiver)
RXPD R16
4.7 kQ
R13
jlo kQ =
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255 Signal Header

To allow easy access to many of the system signals, a header (J2) was placed on one
of the edges of the board. This allows the signals from the MCP2140, PIC18F1320 and
other system signals to be accessed.

The header (J2) RESET signal is the RESET pin of the MCP2140 and not the signal
from the RESET switch.

If desired, the PIC18F1320 could be electrically removed, and the remaining MCP2140
circuitry could be interfaced to another system board for quick system validation. The
PIC18F1320 can be electrically removed by either:

1. Physically removing the device.

2. Erasing the PIC18F1320’s program memory (after device reset, all pins are
inputs).
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NOTES:

DS51487A-page 24 © 2004 Microchip Technology Inc.



MCP2140 IrDA® STANDARD
WIRELESS TEMPERATURE SENSOR
MICROCHIP DEMO BOARD USER’S GUIDE

Appendix A. Schematic and L ayouts

A.1 INTRODUCTION

This appendix contains the following schematics and layouts for the MCP2140 IrDA
Standard Wireless Temperature Sensor Demo Board:

« Board Schematic - Digital circuitry

« Board Schematic - Analog circuitry

« Board - Top Layer

* Board - Bottom Layer

« Board - Ground Layer

« Board - Power Layer

A.2 SCHEMATICS AND PCB LAYOUT
Figure A-2 shows the schematic of the digital circuitry, while Figure A-3 shows the
analog circuitry for the MCP2140 receiver circuitry and transmitter circuitry.

Figure A-4 through Figure A-7 show the layout for the four different layers of the
MCP2140 IrDA Standard Wireless Temperature Sensor Demo Board. The layer order
is shown in Figure A-1.

FIGURE A-1: LAYER ORDER

Top Layer
——
—— — Ground Layer

I - — Doyer Layer
I
e Bottom Layer

A2l Electronic Change Notice (ECN)

There are 3 ECNSs to the Rev. 1 version of the board. Two relate to the use of alternate
optical transceivers and are discussed in Appendix E. “ Alternate Optical Transceiver
Implementation” . The third relates to the pinout of transistor Q6 (MMUN2111LT1). An
incorrect pinout was specified, so the device needs to be rotated 1 pin in the clockwise
direction. Figure A-8 shows how this change will appear.
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BOARD SCHEMATIC - PAGE 1

MCP2140 IrDA® Standard Wireless Temp Sensor Demo Board

FIGURE A-2:

© 2004 Microchip Technology Inc.
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BOARD SCHEMATIC - PAGE 2

FIGURE A-3:
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FIGURE A-4: MCP2140 IrDA® STANDARD WIRELESS TEMPERATURE SENSOR DEMO

BOARD LAYOUT - TOP LAYER

102—-00002
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FIGURE A-5: MCP2140 IrDA® STANDARD WIRELESS TEMPERATURE SENSOR DEMO
BOARD LAYOUT - BOTTOM LAYER
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MCP2140 IrDA® Standard Wireless Temp Sensor Demo Board

FIGURE A-6: MCP2140 IrDA® STANDARD WIRELESS TEMPERATURE SENSOR DEMO
BOARD LAYOUT - GROUND LAYER
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FIGURE A-7: MCP2140 IrDA® STANDARD WIRELESS TEMPERATURE SENSOR DEMO
BOARD LAYOUT - POWER LAYER
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A3 ECNS

This section discusses the ECNSs for this board. There are three (3) ECNs associated
with this board. Two are related to the alternate transceiver circuits and are discussed
in Appendix E. “Alternate Optical Transceiver Implementation”.

The last ECN relates to all transceiver circuits. Transistor Q6 was laid out with the
wrong pinout. To correct for this, transistor Q6 needs to be rotated clockwise by 1 pin.
Figure A-8 shows how to connect transistor Q6 on the PCB.

FIGURE A-8: TRANSISTOR Q6 ECN
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WIRELESS TEMPERATURE SENSOR
MICROCHIP DEMO BOARD USER’S GUIDE

Appendix B. Bill-Of-Materials (BOM)

TABLE B-1: BILL OF MATERIALS
Qty Reference Description Mfgr. Part Number
5 C1, C2, C3, C4, |Capacitor, 0.1 pF, 25V, Ceramic, X7R 0603 | Kemet® C0603C104K3RACTU
c1u
4 C5, C6, C13, Capacitor, Ceramic, 22 pF, 50V, NP0 0603 |Yageo America CAP CERAMIC 22PF
Cc14 50V NP0 0603
1 C9 Capacitor, Ceramic, 33 pF, 50V, NP0 0603 | Yageo America 0603CG330J9B200
2 R16 Resistor, 4.75 kQ, 1/16w, 1%, 0603 SMD | Panasonic® ERJ-3EKF4751V
3 R1,R8,R13,R18, | Resistor, 10.0 kQ, 1/16w, 1%, 0603 SMD | Panasonic ERJ-3EKF1002V
R22
3 R21,R23,R24 Resistor, 20.0 kQ, 1/16w, 1%, 0603 SMD Panasonic ERJ-3EKF2002V
2 R5,R7 Resistor, 100Q, 1/16w, 1%, 0603 SMD Panasonic ERJ-3EKF1000V
4 R4,R19 Resistor, 100 kQ, 1/16w, 1%, 0603 SMD Panasonic ERJ-3EKF1003V
4 R2,R3,R6,R11 |Resistor, 475Q, 1/16w, 1%, 0603 SMD Panasonic ERJ-3EKF4750V
2 R25 (Optional - Not Populated) Not Used NOT USED
4 D2, D3, D4, D5 |Led, Red, Clear, 0805 SMD Lite-on LTST-C170CKT
3 Q3,04,Q5 Transistor, GP, PNP, AMP, SOT-23 Fairchild® MMBT3906
Semiconductor
1 Q6 RF, Bipolar Transistor, 50V Collector-Emit- | ON Semi® MMUN2111LT1
ter Voltage, 5.0 mA Current Rating
1 Ul PIC18F1320 Microcontroller Microchip PIC18F1320-I/SS
Technology Inc.
1 U3 MCP2140, Infrared Communications Microchip MCP2140
Controller Technology Inc.
1 u4 TC1047A, Linear Voltage Output Microchip TC1047AVNB
Temperature Sensor Technology Inc.
2 Y1,Y2 Crystal, 7.3728 MHZ, 20 pF, SMD Esc Inc. ECS-73-20-5PDN
2 S2, Reset Switch, Tact, 6MM, MOM, 100 GF Omron® B3F-1000
1 BAT1 Holder, Battery, 3-Cell, AAA, pc mount Keystone 2479
Electronics®
1 JP1 Conn, Header, 2-Pos .100 Vert Tin Moldex/Waldom™ | 22-28-4020
1 J1 Conn, Mod Jack ,6-6 R/A PCB 50AU AMP/Tyco A9049-ND
Electronics

© 2004 Microchip Technology Inc.
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TABLE B-1: BILL OF MATERIALS (CONTINUED)
Qty ‘ Reference ‘ Description ‘ Mfgr. Part Number

Default Optical Transceiver - TFDU 4100

1 u2 TFDU4100-TR3, Infrared Transceiver, Vishay® TFDU4100-TR3
900 nM, wavelength, 3

1 R10 Resistor, 47.5Q, 1/10w, 1%, 0805 SMD Panasonic® ERJ-6ENF47R5V

1 R26 Resistor, 14.0Q, 1/10w, 1%, 0805 SMD Panasonic ERJ-6ENF14R0V

1 Cc17 Capacitor, Tantalum, 4.7 pF, 16V, 10% SMD Kemet® T491B475K016AS

1 C18 Capacitor, 0.1 pF, 25V, Ceramic, X7R 0603 | Kemet C0603C104K3RACTU

Alternate Optical Transceiver 1 - TFDU 4300

1 U5 TFDU4300 Vishay TFDU4300

1 R14 Resistor, 47.5Q, 1/10w, 1%, 0805 SMD Panasonic ERJ-6ENF47R5V

1 R28 Optional Current limiting Resistor 1/16w, Panasonic Application dependant
1%, 0603 SMD

2 C7,C12 Capacitor, 0.1 pF, 25V, Ceramic, X7R 0603 | Kemet C0603C104K3RACTU

2 C15, C16 Capacitor, Tantalum, 4.7 pF, 16V, 10% Kemet T491B475K016AS
SMD

Alternate Optical Transceiver 2 - HSDL 3000

1 U6 HSDL-3000#007 Agilent® HSDL-3000#007

Technologies

1 R27 Resistor, 6.80Q, 1/8w, 1%, 0805 SMD Yageo America 9C08052A6R80FGHFT

1 C19 Capacitor, Ceramic, .47 pF, 10V, X5R 0603 | Kemet C0603C474K8PACTU

1 C20 Capacitor, 6.8 pF, 16V, Tantalum TE Smd | Panasonic ECS-T1CY685R
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Appendix C. MCP2140 Connection Sequence Overview

FIGURE C-1:

HIGH-LEVEL MCP2140 CONNECTION SEQUENCE

Primary Device

Normal Disconnect Mode (NDM)

No IR Activity
(for 10 seconds)

Send XID Commands
(time slots n, n+1, ...)

(approximately 70 ms
between XID commands)

Finish sending XIDs
(max time slots - y frames)

Broadcast ID

Discovery  gend SNRM Command

(w/ parameters and
connection address)

Open channel for IAS Queries

Send IAS Queries

Open channel for data

Normal Response Mode (NRM)
Send Data or Status

Send Data or Status

Shutdown link

No IR Activity
(for 10 seconds)

VA

MCP2140
(Secondary Device)

PHACT pin driven low

PHACT pin driven high
No Response

XID Response in time slot y,
claiming this time slot, (MCP214X
always claims time slot 0)

No Response to these XIDs

No Response to Broadcast ID

UA response with parameters
using connect address

Confirm channel open for IAS

Provide IAS responses

Confirm channel open for data

(MCP2140 DSR pin driven low)

Send Data or Status

Send Data or Status

Confirm shutdown
(back to NDM state)

PHACT pin driven low
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NOTES:
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Appendix D. MCP2140 250 Byte Data Transmit Table

TABLE D-1: PIC18F1320 250 BYTE DATA TRANSMIT TABLE
TXTBL DT D 250’ ; the first byte is the byte count
;1 Characters

DT “12345678", 0x0D, Ox0A ; 10 Characters
DT “2BCDEFGH’, 0x0D, Ox0A ; 10 Characters
DT “32345678”, 0x0D, OxO0A ; 10 Characters
DT “4bcdef gh”, 0x0D, O0xO0A ;10 Characters
DT “52345678”, 0xO0D, Ox0A ;10 Characters
DT “6BCDEFGH’, 0x0D, OxO0A ;10 Characters
DT “72345678", 0x0D, Ox0A ; 10 Characters
DT “8bcdef gh”, 0x0D, OxO0A ; 10 Characters
DT “92345678”, 0x0D, OxO0A ; 10 Characters
DT “ ABCDEFGH', 0x0D, OxO0A ;10 Characters
DT “B2345678”, 0xO0D, Ox0A ;10 Characters
DT “Cbcdef gh”, 0x0D, O0xO0A ;10 Characters
DT “D2345678", 0x0D, Ox0A ; 10 Characters
DT “EBCDEFGH', 0x0D, Ox0A ; 10 Characters
DT “F2345678”, 0x0D, Ox0A ; 10 Characters
DT “1lbcdef gh”, 0x0D, O0xO0A ;10 Characters
DT “22345678", 0x0D, OxO0A ;10 Characters
DT “3BCDEFGH’, 0x0D, OxO0A ;10 Characters
DT “42345678", 0x0D, Ox0A ; 10 Characters
DT “Sbcdef gh”, 0x0D, OxO0A ; 10 Characters
DT “62345678”, 0x0D, OxO0A ; 10 Characters
DT “7BCDEFGH’, 0x0D, OxO0A ;10 Characters
DT “82345678", 0x0D, OxO0A ;10 Characters
DT “9bcdef gh”, 0x0D, Ox0A ;10 Characters
DT “a2345678”, 0x0D, OxO0A ; 10 Characters

; NOTE: 0xO0OD = Carriage Return, OxOA = Line Feed
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NOTES:
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Appendix E. Alternate Optical Transceiver | mplementation

E.1 INTRODUCTION

This appendix contains the description for implementing either of the other two optical
transceiver implementations.

Note 1: When performing either of these alternate optical transceiver
implementations, please make sure to remove all of the components that
are related to the TFDU 4100 implementation.

2:  Some component value modifications may be required to ensure that the
IR131A electrical specification is met. This may require different values
for the following components R13, R18, R16, R17, C9 and Q6 (which
may then require R15 and R20).

E.2 HIGHLIGHTS

Diagrams included in this appendix:

* Vishay TFDU 4300 implementation
* Agilent HSDL 3000 implementation
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E.3 VISHAY® TFDU 4300 IMPLEMENTATION

Figure E-1 shows the schematic for the TFDU 4300 circuit and the ECN change that
needs to be implemented. Figure E-2 shows how to make this correction on the layout.

FIGURE E-1: TFDU 4300 OPTICAL TRANSCEIVER ECN - SCHEMATIC
vDD
R28 ]
AVAYAY, A us
@ C
ECN VDD 3™
\:— 7 |RX
47 ={sD
WYAYAY * 5 vcc)
4.7uFf1ev [0 14F 4.?u$1 ey |2 1vF -
' — TFDU4300
FIGURE E-2: TFDU 4300 OPTICAL TRANSCEIVER ECN - LAYOUT

ECN Blue wire

Resistor R14 to C16 and C12
connection to VDD (via below
R10)
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E.4 AGILENT® HSDL 3000 IMPLEMENTATION

Figure E-3 shows the correction to the schematic for the HSDL 3000 to be
implemented. Figure E-4 shows how to make this correction on the layout.

FIGURE E-3: HSDL 3000 OPTICAL TRANSCEIVER ECN - SCHEMATIC
ECN VDD \@E
\ R27 -
AVAYAY A
T
2
C19 _|L _iCZE!
RX
47uF L 3
6.8uf Tant
1 7150
o 5 Vcc)
— g GND
HSDL-3888
FIGURE E-4: HSDL 3000 OPTICAL TRANSCEIVER ECN - LAYOUT
ECN Blue wire
HSDL 3000 Pin 5 at C20
connection to VDD (via at
top of R18)
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NOTES:
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Appendix F. Using AN888 Program with a Palm™ PDA

F1 INTRODUCTION

Microchip also has some example Primary device programs that could be used to
demonstrate the MCP2140 IrDA Standard Wireless Temperature Sensor Demo Board.
These programs were not developed for this demo board and may not be straight-for-
ward to display all modes of operation (such as the “Transmit Temperature” program).
These programs are discussed in the following application notes:

« For Palm OS - Application Note 888, “Programming the Palm 0S® for Embedded
IR Applications” (DS00888)

» For Pocket PC OS - Application Note 926, “Programming the Pocket PC OS for
Embedded IR Applications” (DS00926)

* For Windows XP - Application Note 941, “Programming Windows® XP for
Embedded IR Applications” (DS00941)
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F1l.1 Using the AN888 Program with a Palm PDA

It is recommended that you read Application Note 888 to better understand the
operation of the program.

After installing the .PRC file on your PDA, launch the program (MCP215xDemo) and
you will see the screen in Figure F-1.

FIGURE F-1: MCP215XDEMO MAIN FORM

MCP2 15X Derno Application
IF; Link Established M

[ ReadData | [ Clear Data |

# of Sodas Sald =
# of Candies Sold =
Change Box (3% fully =

(R JRscl

T Data {ASCIY =

Trace:0Bytes [ Show ] [ Reset |
Kevboard (123 J[AET |

The following procedure describes how to operate the “Transmit 250 Byte Data String*
program on the MCP2140 IrDA Standard Wireless Temperature Sensor Demo Board.
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F.1.1.1 OPERATING THE “TRANSMIT 250 BYTE DATA STRING” PROGRAM

1. Ensure 3 AAA batteries are properly inserted into the battery holder.

2. Connect JP1 and JP2 (closed position). The power LED (D5) will turn on. After a
few seconds, the PHACT LED (D4) will also turn on, indicating that the MCP2140
is in the Non-Discovery Mode (NDM) state.

3. Depress and release the RESET button.

Turn on the Palm (or equivalent) PDA.

5.  With both devices on a flat surface, place the Palm PDA about 25 cm (107) away

from the MCP2140 IrDA Standard Wireless Temperature Sensor Demo Board,

pointing the IR port of the Palm PDA (dark red window at the top of the PDA)
toward the two clear LEDs (D1, D6) on the MCP2140 IrDA Standard Wireless

Temperature Sensor Demo Board.

Open the MCP215xDemo program on the Palm PDA.

Tap the Connect button.

Tap the 123 button.

Tap any number (0-9). This is the command that will be received by the

MCP2140 IrDA Standard Wireless Temperature Sensor Demo Board, instructing

the program to send a data string back to the Palm PDA. At this time, the DSR

(D2), CTS (D3) and PHACT (D4) LEDs are turned off.

10. Tap on the DONE button. The number selected in step 9 will be displayed on the
line “TX Data (ASCII) = x” (where x is the number). Notice that the line that shows
“Trace:” indicates 0 bytes.

11. To transmit this data byte, tap on the Send button. Notice that the value in the
trace buffer increases up to 250 bytes.

The DSR LED will turn on, the CTS LED will strobe until all the data has been
transmitted and the PHACT LED will turn off.

12. To see the received data, tap on the Show button. This shows the contents of the
trace buffer. The trace buffer window should display a string of data as shown in
Figure F-2.

»

© o N

FIGURE F-2: MCP215XDEMO TRACE BUFFER WINDOW AFTER
RECEIVING 250 BYTE DATA STRING

32345678
4bcdef gh
52345678
6BEDEFGH
72345678
8bcdef gh
92345678
ABCDEFCH
B2345678
Cbcdef gh

F2345678
1bcdef gh
22345678

13. To close the trace buffer, tap the OK button.

14. Repeating steps 8 through 11 will cause the Palm PDA to transmit another data
string of 250 byte. Notice that the trace buffer counter increments by 250 each
time.

15. To clear the trace buffer, tap on the Clear button

16. To disconnect the IR link, tap the Disconnect button. The DSR and CTS LEDs
will immediately turn off and the PHACT LED will turn on in about 10 seconds.
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F.1.1.2 OPERATING THE “TRANSMIT TEMPERATURE” PROGRAM.

1. Ensure 3 AAA batteries are properly inserted into the battery holder.

2. Connect JP1 and JP2 (closed position). The power LED (D5) will turn on. After a
few seconds, the PHACT LED (D4) will also turn on, indicating that the MCP2140
is in the Non-Discovery Mode (NDM) state.

3. Depress the RESET and S2 buttons, then release the RESET button (keep the
S2 button depressed).

4. Release the S2 button.

5. Turn on the Palm (or equivalent) PDA.

6. With both devices on a flat surface, place the Palm PDA about 25 cm (10”) away
from the MCP2140 IrDA Standard Wireless Temperature Sensor Demo Board,
pointing the IR port of the Palm PDA (dark red window at the top of the PDA)
toward the two clear LEDs (D1, D6) on the MCP2140 IrDA Standard Wireless
Temperature Sensor Demo Board.

7. Open the MCP215xDemo program on the Palm PDA.

8. Tap the Connect button.

9. Tap the 123 button.

10. Tap any number (0-9). This is the “command” that will be received by the
MCP2140 IrDA Standard Wireless Temperature Sensor Demo Board, instructing
the program to send a data string back to the Palm PDA. At this time, the DSR
(D2), CTS (D3) and PHACT (D4) LEDs are turned off.

11. Tap on the DONE button. The number selected in step 9 will be displayed on the
line “TX Data (ASCII) = “x” (where x is the number). Notice that the line that
shows “Trace:” indicates O bytes.

12. To transmit this data byte, tap on the Send button. Notice that the value in the
trace buffer increases by 11 bytes approximately once every second.

The DSR LED will turn on and the CTS LED will strobe until all the data has been
transmitted, and the PHACT LED will turn off.

13. To see the received data, tap on the Show button. This shows the contents of the
trace buffer. The trace buffer window should display a string of data as shown in
Figure F-3.

FIGURE F-3: MCP215XDEMO TRACE BUFFER WINDOW AFTER RECEIVING

250 BYTE DATA STRING
Tens = 54
Temp = 52

14. To close the trace buffer, tap the OK button.
15. To clear the Trace Buffer, tap on the Clear button
16. To disconnect the IR link, tap the Disconnect button. The DSR and CTS LEDs

will immediately turn off and the PHACT LED will turn on in about 10 seconds.

Note: Temperature value transmitted by the MCP2140 will be dependent on
battery voltage (see Section 2.3.2.2 ““ Transmit Temperature” Program
Description”).
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